Joy of Tournaments User Guide for NSDA District Tournaments [BEFORE]

Things to do BEFORE an NSDA District Tournament

The following notes will help you have a successful first-time experience with the Joy of Tournaments.
The instructions that follow are far from exhaustive descriptions of each process. The Help option in
the software provides you access to well over 500 pages of documentation. The following notes are
geared specifically toward an NSDA District tournament whereas the help pages inside the software

contain a lot of information that may only apply to other tournament styles.

NOTE: This document is part 1 of a 3 part series for NSDA District tournaments.
Part 2 covers tasks DURING the tournament and part 3 covers tasks AFTER the tournament.

Use this as a checklist for things to do BEFORE the tournament:

. Download/Install/Authorize.

. Save your tournament.

. Configure the initial setup.

. Import website registrations.

. Assign codes.

. Create and copy the schedule.

. Add your rooms to the software / assign rooms to events.
. Set up NSDA rules and options.

. Create schematics for IE / Pair debate rounds.

10. If needed, assign judges.

11. If needed, add a judge, enter a school, or add a new entry.

Before the Tournament Process

1. Download/Install/Authorize.

O©CoO~NOUITAWNE

A. Download the software on to your computer/update to the latest version.
Log in to your website and click on the red Administration link and then on Software
Download. Click on Full Version. (NOTE: If this link does not appear, email a request to
add the software to your order to: support@joyoftournaments.com.)

NOTE: You may safely download the software multiple times if necessary for your
tournament. The installation process will not harm your data if you have already begun
preparation for your tournament. The installation process only updates the PROGRAM
leaving your data untouched.

If you download the software more than 1 week prior to your tournament, it is highly
recommended that you repeat the process the week of your tournament to make sure that you are
running the most recent set of updates for your tournament.
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e When you click on this link you’ll see the program downloading into the “downloads” folder.
Depending on your browser will depend on where you'll find it, but you need to open your
download list and click on the Installjoy.exe file. If you see a File Download — Security
Warning dialog. Select the button labeled Run.

e The Setup process will start with a screen that says, “Welcome to The Joy of Tournaments
Setup Wizard”. This will give you the version number it’s trying to install and a
recommendation to close all other applications before continuing. Click Next, and follow the
prompt for installing.

e When the last box appears, be sure to click Launch The Joy of Tournaments and then click
Finish. The Joy of Tournaments should automatically open to the registration box. If not, click
on the Start Menu and open The Joy of Tournaments. (Follow the steps below to license the
software.)

B. License the Software Using the Registration Wizard.

1. Authorize the software. Once the software installs, the registration dialog should appear. If it does
not, go to Help -> Registration.
(QUICK TIP: Click on the button at the top that says, “Register Free Standalone Version”. Click “OK”.
The “Registration succeeded” dialog will appear. Click “OK”.

NOTE: This is the same version you have always used.... MOST tournaments have always used the
Standalone version.

Once the software installs, the registration dialog should appear. If it does not go to Help ->
Registration. Next, click on the button at the top that says, “Register Free Standalone Version.”

NOTE: If you have recently run a tournament, you’ll still need to get a CURRENT key;
otherwise, you risk being returned to “trial” mode when the older key expires.

e You should be directed back to the registration box. The serial number and key will
automatically be placed in the appropriate boxes. Click OK. You will get a box that says,
Registration Succeeded. Click OK and that computer is officially licensed for your
tournament. To begin setting up the software:

NOTE: If you see last year's tournament data, you'll need go to File -> Open and you’ll get
a blank tournament. You may now start setting up the tournament. Be sure to follow all the
next steps to set up the NSDA-specific steps.
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2. Save your tournament.

A. Go to the File menu and select
Save As.

NOTE: You should select a
location on your computer to
save the data for your
tournament. It is recommended
that you do not save on a
network drive. It is also
recommended that you do not
save on a thumb drive. If at all
possible, it is recommended that
you save your work on the local
hard drive of the computer you
will be using for tabulation. It is
also recommended that you

Save As

@

Save in: | i My Documents

~| & @k E-

& e Folder

File name: [".tm

Open

Save as type: lToumament Files [*.tm)]

_v_] Cancel I |

create a separate folder on your computer to store the data. If you will press the Create New

Folder icon (ﬁ'), you can easily create a new folder. Rename the "new folder" to something
appropriate (e.g. "JOT NSDA DATA", or "NSDA Data" — or whatever name you need).

NOTE: You must REPLACE the
"*trn" that will initially appear in
the "File Name" field with a file
name representing your
tournament (e.g. Anywhere
NSDA District Debate).

B. To test that this step has been
completed successfully, EXIT the
application (select File -> EXxit
from the menu). When you exit the
application, you should not see
any questions or prompts appear.
If you do get a prompt of any kind
on exit, one of the steps above
has not been completed
successfully.

Save i_n:l . New folder

-
Name

v & @ ek B
Date modified Type

No items match your search.

< |

File name: I’.tm

Save as type: IToumamen‘l Files ("tm)
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If the program exits without any messages, you should then open it back up. The title bar of
the application should have the name of your tournament that you supplied earlier in this
process. If you see "Untitled Tournament” in the title bar, your data is not being saved properly.

IMPORTANT NOTE: From this point forward, you should never see a red flashing "save"
message in the status bar of the application. If you see this message at any time, you should
immediately STOP what you are doing and save your work. Any time the flashing red "save"
message appears, your data is not being saved.

3. Configure the initial setup.
The next step is to complete the "initial setup”

of the software. The steps listed here are the
most important steps you will perform. Click Sweepstskes | Judges | Options | Swles | Fees |

Tournament Properties

on File -> Properties. You will see a screen General I Awards | Hostlnfo | Watermatks |  Deadines |
similar to the following:
Name
A. Starting in the General tab, enter the title S T 2/ 9/2006 | EndDate| 2/ 972006 ~]
of your tournament in the Name box as
you want it to appear on reports and Backupevery |15 minutes
postings.

Path ]

e Select the correct Start Date and End
Date — NOTE: Be sure these dates
match the dates on your website and [~ ReadOnlyp [ Lettersin Codes ¥ Validate on Exit
DO NOT SKIP THIS STEP.

¥ Reminders | SingleExpand Tree | LogAdds/Drops

e The rest of the defaults will be correct for [ ok | Cocel
all of the other options on the General
tab.
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B. Click on the Host Info tab. You

. . ) Tournament Properties @
will see a screen similar to this

one. Sweepstakes | Judges | Options | Stes |  Fees |
General | Awards Host Info ] Watermarks | Deadlines |

e Inthe School field enter the
location of the district
tournament. School

¢ |Inthe NFL District box at the

Coach ]
bottom, enter the name of your
NSDA District (e.g. "Tall Cotton", E-Mail ]
Lone Star”). School Phone ]
Home Phone I
Fax ]
NFL Distrct |
‘ 0K | Cancel | Apply |
. ( - - e
C. Next, click on the Styles tab. You | [ourmament Properties
will see a screen similar to the General I Awards I HostInfo | Watermarks | Deadlines I
f0||owing one. Sweepstakes | Judges |  Options Styles I Fees |

. . [~ TFA Tournament
e Select NFL District Tournament.

. .. [~ FLA Tournament
e If have special permission from

NSDA to use this option, select [v" NFL District Tournament

Accelerated Elimination. [ Accelerated Elimination [ Bonus Qualifications [0
e Select California plan if you plan L |iCaleoinis Ean

to use this method of tabulation. [ PhiRho PiNationals
e If your district has earned the [~ PBCFL Toumnament

option of having bonus [~ CHSSA State Tournament

gualifications, select Bonus [~ NCFL Nationals

Qualifications. In the box next to
it, indicate how many qualifiers.
NOTE: Enter the TOTAL number

of slots — not the ‘extra’ slots) your ok | cancel
district has earned.
e Press OK.
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4. Import events and website registrations.

The website import will give you a head start on some of the following steps, so if you are doing
this setup work in advance of your tournament, you may repeat the import process again closer to
your actual tournament. Prior work on rooms and rounds will not be lost when importing data.

¥ Practice HS Tounament - The Joy of Tournaments -
[File] Edit View Repons Help
New

Sef]
Events

0 Everts

A. OPTION A: QUICK IMPORT
- Click on File->Import
Website Entries->Enter your
email address and password.

Restore

Copy to Floppy

Print. CirfeP
Print Setup.

e A dialog box will appear that
is labeled, Web Import ->
Locate Data Files. The
default option, Download
directly from
joyoftournaments.com has
already been selected. Type
in your email address and
your password. Click Next. A
dialog box will appear
indicating the download is in
progress.

Propesties
Assign Codes

L
Generate Web Pages
Email Results
1 Samplearn
2 07ncfipfd.tm
3 play.tn
4 FAoplaytm

Bxit

NUM

Staodalone: 7.7.1

e The next box that will

s

Web Import -> Map Events

appear is the Web Import
-->Map Events box. Event Mapping Unmapped Web Events
Event Web Event Web Event |
e |f there are no items in Dramatic Performa.. International Extemp
Foreign Extemp Dramatic Interp
the Unmapped Web Domestic Etemp  Domestic Extemp

Humorous Interp
Original Oratory

Humorous Interp
Original Oratory

The events listed in
his area are the ones

Events box, click Next.

Duo Interp Duo Interp h h b
CXDebate C-XDebate that the website
NOTE: If there are an | | L-D Debate L-D Debate s
events in the y ' | Public Forum Deba... Public Forum doesn’t find _an exact
Senate Senate match for in your
“Unmapped” box, you hiouse House IThe events listed on the | | tabulation software.

will need to tell the
computer how to match
them. The items on the
left in the Mapping box
are the ones that have
been created inside the
tab software. The events

The events listed
on the left are
{the ones that you
created inside
the tabulation

software.

right are the ones that
are on the website and
are trying to import.
The events on the right
need to match the ones

on the left.

Click on the event
name to match it to
the correct event in
the next steps.
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in the middle of the Mapping box are the ones that are available on the website. The events
need to match in order to import correctly.

NOTE: An event will be unmatched if the names inside the tab software and on the website
don’t match exactly. For example, the website may have “International Extemp” while you
have created an event named “Foreign Extemp”. The “mapping” process helps the software
know that these two events are actually the “same”.

e To clear the Unmapped Web Import -> Map Events [
Web Events box, double-
CI|Ck on one Of the ItemS in Event Mapping Unmapped Web Events
the U nm ap p ed bOX on the Event : ] Web Event Web Eyent |
. Dramatic Performa... International Extemp
right. Foreign Extemp
Domestic Extemp Domestic Extemp
Humorous Interp Humorous Interp
Original Oratory Original Oratory
Duo Interp Duo Interp
C-XDebate C-X Debate
L-D Debate L-D Debate
Public Forum Deba... Public Forum
Senate Senate
House House
<Back l Next > | Cancel

e Another box will appear with a list of bl f AR R i

potential events that match. Click on
the item that matches. If there are no SnevevBIt OK
other names that are similar and you E;?;?a;'%ieer::rmance
need to create a new one, then click 2 B L
on "new event". Click OK. Repeat this
process for each of the items that
need to be mapped.
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Web Import -> Map Events

e Once the items are mapped,

the “Unmapped” bOX W|” be Event Mapping Unmapped Web Events
empty CI|Ck NeXt Event Web Event Web Event
Dramatic Performa... Dramatic Interp
Foreign Extemp International Exte...
e Repeat the above process as somesiebxeinp  JomesicEilmp
Humorous Interp Humorous Interp
needed for any unmapped Original Oratory Original Oratory
Duo Interp Duo Interp
schools. C-XDebate C-X Debate
L-D Debate L-D Debate
Public Forum Deba... Public Forum
e When the mapping process o oy
has been completed, The Gtatiepretation
Web Import-=>Import Entries
box will appear. Click on

Begin Import. When the
download is complete another cBeck [ New> | | Cance
box will appear to indicate that
the import is complete. Click
Finish.
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B. OPTION B: TWO-STEP PROCESS

Step 1: Importing the website entries from the website to a saved location on your computer.
Log into your website on http://www.joyoftournaments.com, and click on Administration. On the left
under the control panel, click on Export Data. Then, click on the option that says, Export Entries

(Joy of Tournaments Import Format).

Website Export - In

I h led 2| hp/ www joyolioumaments com/tcents v | 45 | x 8 Google o
e A page will appear that is titled, Export = . e —
nggite EntEiF()as. Right click on thpe S ™ e D Aol
blue link that says, Web Download & Sample Tournament
Definition (tourn.txt) and select, Click tournaments Practice High Sehooi - Joa Coach
on Save Target As. (Different e
browsers may show different options, Export Website Entries

i.e., FireFox users will see Save Link
As. Select the option that allows you to
save the file in a location on your bl s

The followng fe i necessary for the Joy of Tournments File -> Import Website Entries option

computer. Web Downlogd Defratron dloum te) |

Exporting loumnament data

Downioad mstructons: nght ek on the lnikk above and select the opton labeled 'Save target 85 10
download your toumament rformation. Save the file on your computer's hard drve somewhere
(make sure 10 make 3 note of where you save the fie). You can then mport the entres via the File
> import Website Entries opton withn The Joy of Tournaments PC tab software

Alematively, you may recenve the file necessary for mmporting rto The Joy of Tournamends via emad
¥ you world e 10 00 50, 18 i the apgeopnate emad address below and press the Button ladbekad
Send Once you chck the send button, check your mbax for the emad. Snce the file will come as an
attachment, you may find the emad blocked or marked as spam by fllers on your computer

Send emad o JoeCoach@oycloumaments com (Send) (back)

Click here for help with this option,

Sl AV ANl La, e b SV LA e PV S AN

e Once you select Save As, and select a
location on to save the data. NOTE: As a default setting, the computer will save the
name of the file as “tourn.txt”. It is strongly recommended that you do not change the
name of the file. Click Save.

Step 2: Importing the website entries from a saved location into the tabulation software. Get
out of the browser, return to your desktop and open The Joy of Tournaments software program on
your computer. Click on File and then Import Website Entries.
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e A dialog box will appear that is , v -
labeled, Web Import -> Locate | web inpon > Locate Data Fies - — i
Data Files. Select the second l
option that says, Load from f
disk (data has been ; " Download drecty bom poycloumaments com (s computer must be comnecied 1o Fa intone)
downloaded separately from |
the website and stored on
disk). Then, click Browse.

® Load hom dak (dans has boen downlaaded separainly Bom ha wolste aad siceed on disk)
Dota Fia Locascn | Biowse l
Chck have foe haily wih fus o0800
Carcel
hen th dialog b Bcee —
e When the Open dialog box appears : -
b 9 bp ' || Lockin pracice high schoo j & @y O

find the file where you saved your

tournament data in the step above in ' ' Lo T = L
Part 1. You are looking for a "tourn” file , - mesm—

H H H ou are 'dng ora
with the (txt extension). Click on Open. N "tourn” fiie with a ("ot

extension on the end of it

Note: You may need to change the |

file type to “Text Files (*.txt). To do

this click on the dropdown arrow in Fée name
the box, “Files of Type” and select Fdes oltype
the text files option.

Open
v | Cancel

Open 33 ead only

e The Web Import — Locate Data Files
box will reappear. Verify that the address/location is correct in the browse field and click Next.

NOTE: Follow the remaining mapping and import process as directed above in Option A.
NOTE: Sometimes, school servers or security firewalls prevent information from coming in from

the internet and may prevent your import. For further assistance and alternatives to this process,
visit http://www.joyoftournaments.com/help/webimport.htm for detailed instructions.

NOTE: By completing the above process you have imported the events and registrations for your
NSDA District Tournament. If you’re not using the website for registration and need help setting up
the events, you'll find instructions in this document -> Tab Software Training Notes.
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5. Assign Codes

You will need to assign codes to schools AND students for your NSDA tournament (especially if
you’ll use the Up/Down Method). NOTE: Each school should be assigned a letter code.

A. Assign School Codes - There are two methods for assigning school codes.

OPTION A: You may have the software assign fassign Sthool Codes S5
codes to the schools by right-clicking on the
Schools folder on the left-hand navigation tree and ¢ Leteis (Elshahetic schoaloren
select the Assign School Codes option. When the Cancel
. « ” @ Letters (random school order)
dialogue box appears, choose one of the “Letters , ,
. (" Numeric (alphabetic school order)
options.
(" Numeric (random school order)
OPTION B: If you already assigned codes
to the schools as you have received the Code  [E Name [WestieldHighSchool ——
entries, you can hand-enter each school - "
code. Select the Schools folder on the o | el |
. . . . Addr 1 l Phone (h) ]
navigation tree, right-click and select e |
Properties. The edit school dialog will % | P
appear and you’ll enter the letter in the s [— 2 [ Eal |
Code box. AREmal |
MNotes I
Division | ~| ™ Hasédnived [~
District I _j Squad Count [—
e I —] Trophy Points [—
Additional Coaches Affiliated Judges
Add
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B. Assign Student Codes - Once Assign Contestant Codes ]
you have the appropriate codes
assigned to each school, you Method o
may then assign codes to each ¢ Code + Letter
individual competitor. Click File Cancal
- Assign Codes. The Assign (" Code + Number
Contestant Codes box will  Code + Initisls
appear.
(@ NFL (xe uses unique code)
e e ey ot sriers || C s g
tournament. You may wish to select  Sequential Numeric
one of the two "NFL" options. Beginning with fion
NOTE about the NFL options: If (" PRP Nationals

you select the NFL (xe uses unique
code), a cross-entered student will
have a unique code for each event
in which they are entered. If you use the NFL (xe uses 1 code) option, a cross-entered student
will have the same code for both events.

To view the how the codes appear for each student, select a specific school under the Schools
folder. You will see the students from that school appear along with their code in the right-hand
pane.

6. Create and copy the schedule.

Up/Down Method NOTE: You probably won’t know your full schedule ahead of time, but you
should have at least a good idea of how the first two or three rounds of every event will run. You
can always change the schedule "on the fly", but it is recommended that you at least setup the
first two rounds up front.

California Plan NOTE: It is recommended that you set up all your rounds in the beginning since
the NSDA Manual outlines your schedule based on entries.

NOTE: The process of setting up the rounds "on the fly" is the same as it is to do it ahead of time.
If you'll set up a few rounds early, you'll at least be more familiar with the process.
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A. Create the schedule. On the
navigation tree on the left, select the

event and right-click on it. Click on : . "
Rounds

Rounds. When the box appears for s Iﬁoomsl Fess |:Opfons | Misci()
that event, double-click on the rounds Possible Rounds
to add them to the bottom Schedule Round 4 PN
box. Round 5 A

Round 6

Round 7 -

mn. 4N —

Schedule

Round | Date ) Time

Round 1

Round 2

Round 3

oK | Cancel l
(3 — i
e Double-click on the round at the International Extemp Round u
bottom to set the time and select the '
options for your tournament. You will
see a dialog similar to this one. Click
OK.
Cancel
Date [y ~| @ —
Next Round

Prev Hound

Time |0800AM =+
[~ Flight [~ Panel Judges | |
r Flip for Sides [~ Auto Flight Judges
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NOTES TO CONSIDER:

e This is where you will set the flighting and panels for each round. Repeat this process for
each round that you are ready to schedule for the event.

e This dialog changes in appearance slightly based on some of the characteristics that you have
selected about the event you are working with. For example, if you select Round 1 of a debate
event, the option to flip for sides will not be grayed out.

e The program compares actual dates and times internally to determine if two rounds occur at
the same time.

e To edit a round again, select the event and click the Edit button.

&9 NFL Practice - The Joy of

File Edit View Reports Help

H&gals || 2| [<an =] [<anTimes> -] | | set|

e When you click on the
event on the left, you

will see the summary GlE Dramatic Interp -
page on the right. e g 2T
. ~ Y ivancing to Nationals: £ entries =
Review the schedule I femenons rxemp |ggwc|;1£|(aEr:/;2t;
to be sure |t |S properly ;’s::;lef:lggzln;les have not been specified. Entry Fee: $10.00
dlsplayed Make sure Round 1 Friday 8:00am
that the DAY Of each f:;ge:a:e 5 sections currently required
round IS CorreCt Make @ Public Forum Rougdsictions currently required SR
. Congress
sure that the times are || 2 s —— O—
|ISt6d COITE‘Cﬂy If you 8;\;15::55 5 sections currently required
have any problems . e 1 Al Ay .
. = : 2 Beta High School 2
with the schedule, you 8 Actions : Gicen High School 1
5 Epsilon HS 4
may return to the 6 Gomma High Schoo 4
. . 7 lota Preparatory School 1
Rounds dialog again 8 Kappa South High Schoo! 2
dt th d t d 1(1) mugatgolic High School 1
to e I e a es an 13 PsiEast High School 3
igma High School
times until the e i oo :
Summary page 20 Zeta High School 4
appears correctly.
For Help, press F1 Standalone: 12.5.1555
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B. Copy the Schedule/Rounds to Other
Events - Since it is common that several
events will run with a common schedule, you
may copy the schedule from one event to
another. Right-click on the event and select
Copy Rounds.

e Select the events that have the same

schedule from the list of events that appear
and then press OK to copy the schedule.

7. Add your rooms to the software /

assign rooms to events
Name “
A. Add rooms. To enter the inventory v
of available rooms, right-click on Buidng | #
Rooms on the left-hand side. You Netes |
will see the Edit Room box appear. .
s Availabilities
e NOTE: You will only *need* to enter Date  |Friday -] e
the room number in the Name box Fom [0B00AM —
and then hit Enter. By default, the |
rooms are ALWAYS AVAILABLE. L
Enter times ONLY if the room has _ .
a SpeCial schedule. v Pr'ellms B Pteffar ™ Special Needs
™ Elims I~ Avoid
™ Finals ™ Split
e The only field that is required on this

Copy Humorous rounds

Dramatic
Orator
US Extemp
International Extemp
Diuo Interpretation
L-D Debate

Policy Debate
Public Forum

oK

Cancel

Clear aAll

I g

Select All

Close

“owe |

™ Unavailable

screen is the name of the room. The

name of the room should be listed the way you want the room to appear on postings when this
room is assigned. Examples: Room 10, ZACH 304, JH 102. The names should be relatively
short (12 - 15 characters) although you may use anything you want. If you use longer names
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for the rooms, there are some reports which will not be able to display the full room name.

e As you enter the rooms

* Jay lnvitstional - The Jay of Toursamenis

that are available, the B 6% Ve Boors tep = —

" " . CICCIEIER T ] 54

Room Usage” report will -5+ Room Usage s
be updated to reflect  Saam IO .-

each room you have =t i S e e

entered.

e Continue entering rooms
until you have your room
list entered. If you leave a
room off, you may always
come back later and add
it, but entering the room
inventory early is a good
idea.

e Should you need to make
a correction to a room
(correct spelling, change
the times the room is ¢ 2

available, add notes, — -

etc.), you may do so by moving your mouse over the name of the room in the right-hand
window (where the Room Usage report appears). As you move your mouse over the name of
the room, the room name will turn blue. When the room turns blue, right-click and select
Properties from the menu.

B. Assign rooms to events. After you have completed the room inventory list, you may begin
assigning rooms to specific rounds and events. To do this, go to the events folder on the
navigation tree and find an appropriate event. Right-click and select the option labeled Rooms.
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e A dialog box for the event will appear.

At the top of the dialog next to the B g | zs
Round is a drop-down list of the _ _ :
rounds you have scheduled for the Basic | Rounds Rooms |Fees | Options | Misc |

event. Select the appropriate round

from the list. Round | ‘

e Alist of the rooms that are available

Round 1

during the time frame you have 2T BRI
indicated for the specific round of the Ragman = ¥
event will appear on the left-hand side Fodm2l | [ 19
of the dialog (under the heading of 2222;@ E
Rooms. A room is available if no Room 24 i
other event is scheduled to use the Room 25 t
room at the time specified for this Room 26 |
round and the room has not be Room 27 b4
indicated as unavailable at that time. Show Al @ Available
e NOTE: At the bottom of the dialog ’Tl Cancel

there are two radio buttons. One is
labeled All and the other is labeled
Available. Initially, the radio button labeled Available will be selected. When the Available
option is selected, the left-hand list will only contain the rooms which are not in use at the
same time as the round you have selected at the top of the dialog. If you select the All option,
the left-hand list will show all rooms from the inventory of rooms regardless of availability. It
should only occasionally be necessary to switch over to the All option.

e The rooms that appear on the left-hand side are color coded to provide you with additional
information about the rooms. The color code is as follows:

Background Color Meaning
White Room is available for use
Room has not been indicated as appropriate for this specific round
Black o
although it isn't in use
Red Room has been marked as Unavailable
Room is in use by another event at the time this round is
Gray
scheduled
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display each of the rooms that you have P

selected for use during the selected Basic | Rounds Rooms | Fees | Options | Misc |
round. To move a room from the list on
the left-hand side of available rooms to Round  [Round 1 | Fiios00aM
the right-hand side of selected rooms, : , e
there are two options: 39 Entries: 3 sections of 5 a’ 4 sections of B
Speaker goal of 7 requires B rooms
v' Select the room on the left with Rooms Selected Rooms (7)
the mouse. When the room has Library A~ | Room 116
been highlighted, press the >> Portable 1 I Eggmﬂg
button in the center of the dialog. Portable 2 Room 115
Multiple rooms may be moved Portable 3 New | |Room 117
together using this method. Fortdble 4 e Room 114
: , Room 110 Edit ] Room 113
v" Double-click on a room in the e T 1L
left-hand list of rooms. e ‘o | View |
NOTE: To remove a room that has been Show Al ¢ Available
selected for use (in the right-hand list of
rooms), simply reverse the process oK Cancel |
(double-click on the unwanted room or

click on it and click the << button.

e Repeat this process for each round of the event until all needed rooms appear in the Selected
Rooms list on the right.

e If you wish to double-check the room assignments for an event, you can easily return to this
view by right-clicking on the Round then click on Rooms.
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C. Understanding the
Room Usage page - A

t NFL SAMPLE - The Joy of Tournaments
File Edit View Reports Help

Bs=lJ[E| 2|

| [<ali Time ~] |

| set| [cay

i, A iy A MY

“‘grayed out” bar 5 CEvens Room Usage
indicates the room is = O Friday, 03/07/08
. H ! F
being used. You can ® SDomestic Extemp 8:00 9:00 10:0011:00noon 1:00 2:00 3:00 P
. . ] Original O Y
quickly see which rooms e — b Room1 ‘
. . e s Room 2 Z
are in use and which 3-8 Dramatic Interp b Rooms ;
. . 3} L;I Duo Interp P Room 4 P
rooms are still available 5-C3 C-X Debate p  Room5 ‘
. . . & i Ri 6
during different periods T | 2 rowst 3
i (3 Rooms P Room# <
of time. If a room has 8 p  Room9 7
been over-scheduled e r Rt /
- ( ctions 7
during one of the time R on] b Foom2 ¢
ingone o o Q1Rouno 2 b Roomig S
periods it is in use, the =03 Round 3 p Room15 3
R (2 Round 4 p Room 16 <
bar representing that &-C1 Round 5 p  Room17 3
. . . D CAE R 18 P
time period will be red. el b Room19 5
. ; R 20 e
The bar for a room will  @oweroffinsh | b Room2i g
. . @3 L-D Debate p Room22 X
also appear in red if the - @ Public Forum P Room2s 3
room has been marked =~ ® Dschoots 5 Rom2s y
, @ Judges p Room26 <
as Don’t Use. If a black = <rooms p Room27 3
. 6 R 28 P
bar appears, it e o b Room29 g
‘ ’ ~ 8 R 30
represents an ‘extra @32 Actions b Room >3t !
. . p Room 32 ?
room that is available at p  Room33 : : ?
ALSISIINI P Lo P o PP ., 1 o1 [ TP T SF PR s st St

that time, but has been
assigned to a particular event.

. ’_ NFL SAMPLE - The Joy of Tournaments
e You can view the

File Edit View Reports Help 7
assignments for a Hism| i) #lan ~| [<anTime -] | | set| [can>  ~ ¢
specific room by pausing  ~ ™S s Room Usage
over the room's name & QInternationa[ Extemp Rl st ;

. (3 Domestic Ext 00 o 0011 00 200 3 <
Wlth the mouse. When i - oz;’;:;';ratzzp 8:00 9:00 10:0011:00noon 1:00 2:00 3:00 /
you hover over the room, - Humorous Interp oS 5535 R ass 3

t. ” | t & !__'JDramatlc Interp p  Room|l ’,l
a up will appear listing (2 Duo Interp p  Room |Prelims OK <
each of the assignments =-a E-X DePate P Room |Fri 08:00AM International Extemp Round 1 4/

. @[3 Entries p  Room |{Fri 10:00AM International Extemp Round 2 £

for the room. This -3 Cross Entries g gggm Fri 12:00PM International Extemp Round 3 ;
(e Fri 12:00PM H Interp Round 3

example shows the [amon | 3 o A Z

assignments for Room 1 @ Actions b Room 52L0600PM L-D Debate Fials /

. -6 R 12 A {

where a red bar is T p Room 5 :

indicating a conflict. 5 @ Round 3 b Room15 7

. @[ Round 4 R 16 Z

This example shows a i e : 323:2%

. . Rl p Room P

conflict ywth room 1. i y et 7

When viewing the momEsiEi | 0 Lo Z

assignments you will see =-@ LD Debate B Roomad ¢

& Public Forum p Room23 3

that at noon a round of k-G Schools p Room24 o 7

Fr“,- PPl N SNV RY SOV AR VAL 2070) 21 U2 SN SPW gt el AT A B g ettt s SR Ve L S YR SOV e
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HI has been inadvertently assigned to the same room at the same time the IX round is
scheduled there.

’_WNFI:SAMP?LE - The Joy of Tournaments

. . File Edit View Reports Help
o To eaS”y substitute or H&als el 2|[an +| [<Al Time ~| set] [cany  ~

reassign this room, right- = Seews
C“Ck on the Room (On the (2 Ballot Status

(0 International Extemg

Room Usage
Friday, 03/07/08

-

7

o

v
2

<

. . . z 3 &
nght_hand s|de) and click (3 Domestic Extemp 8:00 9:00 10:0011:00noon 1:00 2:00 3:00 /
. (3 Original Oratory K
5 000vovvee %5 3

on Assignhments. @3 Humorous Interp D RO pertes.. s
&3 Dramatic Interp p | 3 .
2 p  Roor Assignments... y
(1 Duo Interp p  Roor 7

=3 C-X Debate p Root  Delete 7

(3 Entries P ROl 1 aiailable %
@-(3 Cross Entries P Rool . ;

p Root ¥ Prelims ¢

3 Rooms . P

= p  Roor Elims {
(3 Judges p Roof e }
(3 Actions p Roor} iha's ;/

B Round 1 p  Roor Preferred (

-3 Round 2 s sgg: Avoid b
Q Round 3 p Rool Split e

(3 Round 4 p  Root Special Needs 7

=~ Round 5 p  Room7 A 4
&-@ Final p Room18 ¢
i L"_‘JAman p Room19 i

IO p  Room20 <

A (3 Order of Finish p Room21 3

@ L-D Debate p Room 22 <
@[ Public Forum p  Room23 FE :

(3 Schools p Sgom 2; 2 S

prrgprt i s 02 pa iRt BPIZY L oo on ey SR TP sg g P oG J A S FoT 3Pf f sg 6P spf A P

e When the Room Assignments box

appears, click on the event you wish to Roo Ssignments =
reassign. The options on the _right will Rt
become active. Select Substitute. A
Time Cancel |
. ; Fri 08:00AM International Extermp
NOTE: If you wish to remove or move all Fri 10:00AM Intormational Extormp Add
assigned rooms, you may select those options r: temationl Externp
. . 3 tern
as well. This example will show how to St 02.00PM hteraational Cxtome

substitute a room. Sat 06:00PM L-D Debate

Mowve All

Humorous Interp
Assignments

e When the Room Substitution box
appears, select the appropriate room and
select OK. The Room Assignments box
will reappear. Verify that the event disappeared and click OK again.

¢ Onthe Room Usage page, the red bar will have disappeared.

Round 3
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NOTE: You may also filter this
Room Usage page to view
only certain days of your
tournament. For example, if
you are running a two-day
(Friday & Saturday) tournament
and you only want to view the
Saturday Rooms, you may do
so. Click on the drop-down
arrow at the top of the page
(just to the left of the “Time”
option). The dates of your
tournament will appear. Select
the date you wish to view and
the Room Usage view on the

: NFL SAMPLE - The Joy of Tournaments

[BEFORE]

File Edit View Reports S 7
EIE=RG <all> Nl Time ~ | | t

| set| [can>  ~

(3 Events <all>
-3 Schools Friday, 03/07/08
(3 Judges Saturday, 03/08/08
=3 Rooms
£ Map
(1 Estimates p Room1
@ North p  Room2
2 i p Room3
B by Time p Room4
(3 Unscheduled p Roomb5
@1 by Name p goomg
w1 Sweeps p oom
-~ p Room8
9 Schedule p Room9
& Actions p Room10
p Room 11
p Room12
p Room13
p Room 14
p Room15
p,, Room 16
SNP 2222 P 3OS in PSR L b NGl 0y b p 0 J

right-hand side will change to reflect your requested date.

e Another option for
viewing room
assignments is to use
the room Grid. To view
this grid, open up the
rooms folder and click on
Grid.

NOTE: This feature may
also be filtered to view only
certain days of your
tournament. For example, if
you are running a two-day
(Friday & Saturday)
tournament and you only
want to view the Saturday
Rooms, you may do so.
Click on the drop-down
arrow at the top of the page
(just to the right of the “J”,
“‘E” and yellow “?” buttons

Room Usage

Friday, 03/07/08

8:00 9:00 10:0011:00noon 1:00 2:00 3:00

AN ANAAAN WA DA AAAA AIAAN LA

PR AN

. NFL SAMPLE - The Joy of Tournaments

File Edit View Reports Help

B2l E| 2 [<an

| [<alTime ~ | set| [cany  ~

-1 Events H
-3 Schools Room Grld
= u Judges Fri Fri Fri Fri Sat Sat Sat Sat
-3 Rooms 800 1000 1200 _ 2:00 200 400 600 800
3 Grid
8 Estimates Room 2 X X X X LD
E :;2 t"e Room 3 IX IX HI
& Unscheduled Room 4 px | bx | bx DX | DX DI
@3 by Name Room 5 DX DX DX DX
- Sweeps Room 6 DX DX
B schedule Room 7 oo | oo | oo | oo oo | oo 00
B Actions Room 8 00 | oo | oo | oo 00 | oo
Room 9 00 00 (o]0 00
Room 10 (e]e] (e]e] 00
Room 11 [e]e) 00 00
Room 12 HI HI
Room 13 HI HI HI HI HI
Room 14 HI HI HI
Room 15 HI HI HI
Room 16 DI DI DI DI DI DI
Room 17 DI DI DI DI DI DI
Room 18 DI DI DI DI DI DI
Room 19 DI DI DI DI DI
Room 20 DI DI DI DI
Room 21 DUO DUO DUO DUO [a]V]e]
Room 22 DUO DUO buo DUO
Room 23 DUO DUO DUO
Room 24 DUO | DUO
Room 25 CX CcX CX CX CX CX
Room 26 CX CcX CX CX CX CcX
Room 27 CX CcX CX CX CX
Room 28 CX CX CcX CX
NS\ G207 SatV S VY A SEN NN vy ST PINP TS INPT PV VAV A S e

WAV VNPT aNS

and to the left of the “Time” option). The dates of your tournament will appear. Select the date
you wish to view and the Room Usage view on the right-hand side will change to reflect your

requested date.

ANCNAAR SUA AN AN A Y

AMAN

AAAAANANANANAAMARNANANAMAACANGAAIAAIN AINAAA AN,
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8. Set up NSDA rules and options. Add Event

In order for the events to tabulate

Basic | Rounds | Rooms | Fees | Options Misc I
according to NSDA rules, you will need to

select the necessary options for each Tabulation Method | ~|  Edt. I
event. To do this right-click on the.event Brefim Baskiag Hiibs EE% Edit l
and select Properties and then Misc.) Slate FLA (2005) L=—
NOTE: Repeat these options for each Raaks FLA (Original) [ =~
event.) NFL Type Eggé& j
] Duration {in minutes) FL Foints -

A. Set the tabulation method. From the _ PED

dropdown menu next to Tabulation Single Performance | | TFA o

Method, select NFL. NOTE: You Entire Round ] g'ép 0

should IGNORE the "Prelim Ranking
Rules". Speaker Goal ] 7 Copies 0

-
B. Choose the ballot style.

0K Cancel l Apply

e For each IE event, there is a specific
NSDA ballot. Next to Ballot Style,
select the appropriate NFL ballot.

e Print IE ballot. Open the Event folder on the left and then right-click on the round folder.
Then select Print All Ballots.

e For Public Forum select Debate — Team Points from the dropdown menu.

e ForLincoln-Douglas and CX Debate select Default from the drop down menu.

Print Debate ballots: Open the Event folder on the left and then right-click on the round
folder. Then select Debate Ballots. You may add notes (e.g., the topic) in the Message box.

e You should IGNORE the Single Performance and Entire Round "duration" fields. The
defaults (indicated by a zero) are sufficient. You can safely IGNORE the minimum and
maximum speaker points because for NSDA districts all that is necessary is a win/loss record
in debate.

e You should IGNORE the speaker goal because the speakers per section is outlined by the
district tournament manual and the software knows about the chart. DO NOT check the "All
ballots form virtual panel for finals" option. Click OK.
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Set miscellaneous options.

e Next, you will click on the Options tab.
Depending on the event will depend on
what options are not “grayed out” and
are available for use. For Dramatic
Interpretation, Humorous Interpretation
and Duo Interpretation you will need to
select the Track Selections option.

e For Public Forum, you will need to select
the “Label Aff/Neg as Pro/Con (Public
Forum)” and “All rounds flip (Public
Forum)” options.

Humorous Interp Properties &J
Basic I Roundsl Roomsl Fees Options IMisc I
[~ Track Selections ENGIESEOpE
: — [~ All Placings
[T Exclude Results [~ Non-Placing
I'_ =5
5 [v' Complet
v Complete
W P
r
m o
[ Elim breaks notroom-based [ M
-
OK | Cancel |
Public Forum Properties &J

Basic I Roundsl Roomsl Fees Options IMisc I

[~ Track Selections Award Script
Il : [~ AllPlacings
[~ Exclude Results [~ Non-Placing
r

[z

M [v' Complete

[ Label AfffNeg as Pro/Con (Public Forum)
[~ All rounds flip (Public Forum) ™ J
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9. Create schematics for IE / debate rounds.

Up/Down Method NOTE: The first two rounds will be automatically created since they are
already pre-set.

California Plan NOTE: For the California Plan, the first round is pre-set. Because the second
round is powered off the first round, the second round will be created after all ballots have been
entered.

A. Create Sectioning for Individual Events or Debate - To create sectioning or pair an event,
right-click on the specific round of the event.

For IE, choose Create Sectioning: For Debate, choose Pair:

006 NFL District lournament - [he Joy of lourn|
File Edit View Reports Help

H|3|=|J | E| 2 [Fiey oziom [

¢ 2006 NFL District Tournament - The Joy of Tourname

File Edit View Reports Help

ué @ J|E g.'l' 0Z2f10/06 _] I— éDgyents
= C_l Events g :allot Status
- ) umorous
\__:] Ballot Status 4+ (3] Dramatic
- Humorous + (] Oratory
+ |_] Entries + [ Us Extemp
+ [_] Cross Entries + [ Internationial Extemp
= + |_] Duo Interpretation
l-_,l Rodoms + (] L-D Debate Room
e l—l Ju _ges = [ Policy Debate
(1 Actions + (1] Entries
+: ﬂm‘ . . | + \:] Cross Entries
+ (] Round Print Postings d Rooms
+ (] Round Print All Ballots + (21 Judges
2t ; (21 Actions
+ l_J Sweep:  Edit Header [ Footer Text.., o S v
(] Award: # (] Rounc  Print Postings
B s Envelope Labels... =
i+ ] Dramatic + (] Rounc  Debate Ballots
i+ \__] Oratory ?a:m: Lgbecljs... + L:_] Sweep  Edit Header | Footer Text...
- udge Cards... [ Aware
i+-1_] US Extem -
+ é Internatiollj' Entry Cards... i f PubjcFory ?azm stecllsm
i - [ Schools Hage NS ey
i Q DuoInterp|  manual Judge Assignments. ., - (3 Judges Enkry Cards,..
#-[JL-DDebate  p g Judge Assignments M H §°°ms Enter Ballots. .,
! i a + Weeps o
l" g Palicy Debs Judge Restrictions & Schecﬁlle Power Detail...
i+ -[_] Public Foru Unassign Judges w3 Acti Manual Judge Assignments. ..
k: &
+ | Schools gt Auto Judge Assignments
3 D Judges Find... Judge Restrictions
o u Rooms Unassign Judges
+ [ Sweeps Rooms Find...
(] Schedule Properties 2
- - ooms
+ (] Actions Enter Individual Ballot. .. Properties
[ creote Sectioning o —
Adjust Cross Entries Pairing Priorities. ..
Round Robin...
Re-Label Round
Re-Label Round
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e For IE, a dialog similar to the following
should appear. If needed, modify the
numbers to reflect the number of
sections you wish to have, and click
OK.

Create Sections.

oK

Dramatic Interp

Entries 32 Cancel
Prelims [_‘-
Sections l—g
Speakers [_?

7 speakers: 5 sections (2 with 7, 3 with B)

6 speakers: 6 sections (2 with 6, 4 with 5)

8 speakers: 4 sections of 8

e When creating a debate paring a dialog similar to the following should appear. Select Yes to
create the debate pairings.

Action Confirmation @

Create Debate Pairings

Yes No l Cancel |
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e For IE, a schematic similar to this one will appear:

b NFL Practice - The Joy of Tournamen C=2ra X
File Edit View Reports Help
B&=lJ]E| 2] [an ] [<anTimes> -] | | set
| &-(3 Events 5 sections missing a judge i 00:2
-[1 Ballot Status Dramatic lnterp H:9 [
(1 Ballots Due Round 1 DUO: 1 |
(1 International Extemp 8:00am

(2] Domestic Extemp
(2 Original Oratory
(23 Humorous Interp
=12 Dramatic Interp
(L] Entries
(2 Cross Entries
(1 Rooms
(2 Judges
-1 Actions
23 Round 1
(1 Round 2
(3 Round 3
-] Prelim Results
([ Sweeps
(1 Awards
-] Duo Interp
(10 C-X Debate
(L] L-D Debate
(2 Public Forum
| -0 Congress
| @3 Schools
- Judges
[
[

-] Rooms
| -0 Sweeps
(10 Schedule
(23 Actions

Section 1 - Room 110
Carolina Reighner
Madison Faast
Henry Eiserman
Laz Grant
Skye Cable
Ester Demuth

N
NSO ;oo =

Section 3 - Room 112
10 llan Kranz
13 Hazel Wade
6 Nick Inez
5 Jordyn Painter
15 Garland Hawkins
19 Angelia Hughes

Section 5 - Room 301
2 Stewart Jackson
7 Nick Lyons
20 Taneka Leonard
11 Greg Ewing
5 Betty Graff
13 Meagan Wilson

19
15

20

13

15

20

19

xL
(o]
=
-~
n

Section 2 - Room 111
Freddy Bloise
Kory Munson
Vanessa Todd
Ethel Coveney
Isadore Gibson
Tristin Thomas
Hazel Vorrasi

Section 4 - Room 113
Ruby Schneider
Elizabeth Dennis
Shania Ruhl
Frederick Ulery
Dawn Merryman
Zachary Taggart
Martha Napier

NOTE: You may edit your schematic on the left by dragging and dropping the students to
different rooms/sections.
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o For debate, the pairing will appear on the right side of the computer screen and look
something like this.

File  Edit View Reports Help
| Ql@im|s €] 2] [Ga - [cAnTime - Set!
S Event -
I L-D Debate
—J Baliot Status
= 3 Humorous Interp Round 1
« 23 Dramatic Interp 12:00am
» J Foreign Extemp
» 2 Domestic Extemp
» A Original Oratory ) .
w21 Duo Interp Room Affirmative Negative
=y 16358 i
% -JC‘; Debate Room 129 2 ¥iouna lmsin & Kim Kershat
=3 1-D Debat
PR Room 130 2 Emily Elvens 8 Rupen Robenson
#  Entnes ¢
s (3 Cross Entries Room 131 3 Ursula Urther 5 Freddy Finch
1 Rooms Room 132 1 Ashiey Adams 7 Orpheha OReily
-2 Rudges Room 133 8 Quinan Queen 6 Jenny Jenkins
j"‘fmm Room 134 6 Linda Luther 4 Harns Henckshel
s 53 Round 2 Room 135 1 Beert Butterworth 8 Sara Sheelkey
# JRound 3 Room 136 5 Doerrve Davis 2 Herman Hemandez
= JRound 4 Room 137 2 Femando Femandez 5 EncEnckson
y "'g:“m‘R""“'“ Rocen 138 8 Peler Panesson 4 Gina Ginger
= A Octo-finals
a0 . .
533 Quarter-finals Room 139 3 Tina Tohler T Mingy Mendleson
# - ) Semi-Finals Room 140 7 Nita Nudent 1 Derek Danels
= L Finals Room 141 3 Violel Victor 2 Gecorge Gherens
= L Sneeps 1 Charles Cuttervilie BYE
< Awards
= 1 Public Forum
= - Congress
= Schools
= J dges
= 3 Rooms
= ) Sweeps
23 Schedule
= - Actions
"
M
Standalone: 7.7.1 NUM

NOTE: You may edit your schematic on the left by dragging and dropping the‘students to
different rooms/sections.
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10. If needed, assign judges - There are two ways to assign judges. You may automatically assign
judges or you may manually assign judges.

NOTE: The website will only allow for entry of “school-affiliated” judges. If you didn’t use the website,
or if you need to add hired or volunteer judges to the tournament you may do so. (See the
Addendum section at the end of this document for details.)

A. Automatically Assign Judges - To automatically assign judges, double-click on the event to
display each of the rounds of the event on the tree. Right click on a Round and a dropdown
menu will appear. Select Auto Judge Assignments.

2 Practice HS Tournament - The Joy of Towrnaments

file Eait View Reports Help

Qsimlsfe] 2[5 1 <A Tiene -1 Set
& Events Humorous Interp
J Ballot Status §
&3 Humorous Ir Round 1
» 3 Entries 12:00am
= Sedecton |
» 3 CrossEnt
23 Rooms Section 1 - Room 121 Sed
o G udges 1 Laureen Link 2 Michede Ma
= Actions | ﬁ‘?_(_n,(’!?j.@,.ﬂ,"!.’@i?:’
= . Print Postings peks
: jkcc Print A% Ballots
253 fin Edit Header / Footer Text.
» 5w Ervelope Labels.
I Aw Ballot Labels..
= ?‘“’T‘ Judge Carcs.
: j ;\_:: Entry Cands.
= (2 Origi Manual Judge Assignments._
= D3Duo i Auto Jodoe Assonments ||
= 2CXDy uage AnChons
= AL0DD Unassign Judges
= 3 Public Check Selections.
= O Congress g
<2 Schools S
= 2 Judges Rooms
= 2 Rooms Sweepstakes
|= I Sweeps Properties
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e When the Assign Judges dialog appears, click OK. You may wish to change some of the
options as displayed on this dialog to modify the judges that are considered in the assignment
process. The Assign Judges dialog box will something like this one:

e The schematic will appear on the right and will now display the assigned judge names.

e NOTE: This does not Assign Judges.
automatically assign judges to |
all events and rounds Public Forum Round 1
simultaneously. Repeat this :
Friday, 01/27/2012 04:00PM
process for each round of each 2 ﬂj
event. Sections

Priority
Student Judge
'A' Rating

: 'B' Rating
Available 'C' Rating

‘D' Rating

'E' Rating
Check-in
Coach

Required

Preferred

Panel Size

Lag Minutes

- Options

[V Retain currently assigned judgest [~ Assign 'ditty' judges

[~ Do not move judges [V Assign unconfimed judges

[V Observe round limits [V Assign judges not checked in

% Consider dity if seen in another event W Assign 'Student Judge' judges
[V &void Judge Tracking a Squad

™ Assign coaches
[” Assign 'hired' judges
™ lgnore judge blocks
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B. Manually Assign Judges

for DEBATE — There are
two ways to manually
assign judges: Viathe
navigation tree or via the
schemattic.

e Viathe navigation tree -
Right click on the Round
and click on Manual
Judge Assignments.

e When the Manual Judge
Assignment dialog
appears, you may make
changes to that round.
(See instructions in the
next section.)

¥ Practice HS Tournament - The Joy of Tournaments

File Edit View Repons Help

BisimiJE] 2 [can 1 [<au Set]
L-D Debate
Round 1
12:00am
& - Onginal Oratory
% 23 Duo Interp Room Affirmative Negative Judge
42 C-X Debate Room 129 4 goana imsn 6 KmKershal Thomas Tears ("3)
‘.“_:";:”:' Room 120 2 Emily Etvens 8 Rupert Robertson Glonn Gungho (3)
4 23 Cross Emries Room 131 3 Ursula Unther 5 Freday Finch Anita Applewaite (*2)
=) Rooms. Room 132 1 Ashiey Adams 7 Orpheta ORely Douvg Drewman (*4)
8 Qunian Queen 6 Jenny Jenkins Josh Juniper (*4)
Room 134 & Linda Luther 4 Harmis Henckshel Zebra Zenith (*8)
Print Postings rent Butterworth 8 Sara Sheeley Jefry Jnkeng ("6)
Debate Ealiots Donme Davis 2 Herman Hemandez Basry Barmhardt ('6)
Edit Header / footer Text. emando Femandez 5 Enc Enckson Bne Benthese (1)
Ballot Labels. eler Patterson 4 Gina Ginget Chares Cupeppes ("6)
Jusge Carcs ina Tohler 7 Mindy Mendeson Cathy Catwiiher {*5)
By Conds.~ 1a Nigert 1 Derek Daniets Beah Beay ('2)

Enter Ballots_

= Public £ N0 JUage Aesigrments
%) Congress Judge Restrictions
23 Schoots Uisision odoes
23 Judge:
# &1 Rooms Find_.
# ) Sweeps Rooms
- %‘W“" Sweepstakes.
ol Properties
Manual Pair..
Paie

Paring Pricrities_
Round Robin.

Re-Label Round

folet Vicior
gharies Cuttenville

2 George Gherers
BYE

Wikma Winner (*7)

Standalone: 7.7.1 NUM
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¥ Practice HS Tournament - The Joy of Tournaments
° 1 1ri ( ) File Edit View Repors Help
Vlathe Pa”'ng Debate B8l E] 2 [ ] [can Time ~ Set
Find the room/sectionon [ =& L-D Debate
- 8 Fhdmcecka Wi Round 1
the pairings of the event e 12:00am
H +- 2 Foreign Ext
you want to assign Gjmnaliped
N . . s 22 Original Oratory . - y
judges. Right click on one | - Sowmes Room Affirmative Negative Judge
42 C-X Dedate Room 129 & Wdokna mean & Kim Kershal Cathy Catwilher (5)
of the student names. &0 0w Room13 2 EmiyEems & Rupet Robedson
4 23 Cross Enries Room 131 3 Ursula Unthec 5 Freddy Finch
When the dropdown sy T peoiey s e
1 o S lages Room 133 8 Quinian Queen 6 Jenny Jenkins
menu appears, click on e S e e ‘
Manual Assign Judges. " 2Rouna2 e Eani e 5 Ogeome '
# =) Round 3 Room 138 5 Donme Dans 2 Swap Sides ‘
© 2 Round 4 Room 137 2 Femando Femandez 5 E nter Ballot. J
¥ Pretim Rewuits Room 138 T Pelor Patieison a
o 3 Octo-Finals o "
4 £ Quarter-Finals Room 139 3 Tina Tohder 7N 1
4 2 Semi-finals Room 140 7 Nita Nidest 1 [ DeleteSection |
o 23 Finals Room T "3 Vioket Vicior 2 € I
f j:::‘: 1 Charles Cuttervile BYE Mack Dropped
« 23 Public Forum Dtsqualtly
# = Congress Novice
# =) Schoot rpener
‘ Jm;s Expenienced
# =1 Rooms v Sweepstakes Entry
# ) Sweeps
3 Schedule
# 3 Actions

Standalone: 7.7.1 NUM

e Viathe —
SChematIC (IE) ile Edit View Reports e|p

<
. . S
<all> *| |<All Times> ~ € X ]
Right click on CIELIER: Set §
E-& -~ = <
one of the room  fj7& e - International Extemp s
numbers or over L3 Ballts Due Boune.d 7
=1 International Extemp 400pm <
one of the 22 Entries 7
d d ({1 Selections 3 %
Su ent codes. (L Cross Entries Section 1 - Roem 101 Section 2 - Room 102 /
(22 Rooms Judge: Carla Clayton ('R) Room... A
When the (23 Judges 5071 Dvian Bushi Manual Judge Assignments... ggi gzzg llzl’eEt;ers ',/
; - ylan Buehler — imball Barnes P
dropdown menu pofiieiid : At1 | 1an Eden New Enty.. At5 Eunice Godied 4
H il C10 | Anona Dugmore Delete Section C06 Amanda Benson 3
appears, click (O Round2 J03 | Doris Akers RO03 Lamry Brynu -4
(3 Round 3 005 | Nora Smith 7
on Manual £ Round 4 g
. (3 Awards Section 3 - Room 103 7
AS SI g n -1 Domestic Extemp AT S
(-1 Original Oratory lerlin Compton 7
J u d g €s. &1 Humorous Interp Eg; HHZI BAf:jggs ;
-] Dramatic Interp MO6 Lvagy Ki s v
(23 Duo Interp inda franz £
(L] C-X Debate ’/
B (2 L-D Debate :/
RV Gl IV o L ANV W W AV S Y BV S SN O ARY S A W N AV A Y e

¢ When the Manual Judge Assignment dialog appears, you may make changes to that round.
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e Note what section

Of thls rou nd you m Judge Search Search Assigned Judges 08:00 AM Saturday
are editing and N Nou| | CH —
. - nassigne:
3 i
Ch an ge seCtI ons y ecton | T i‘ " UnPooled Judge
. I byBracket - = 1
if needed. If you
. . Y ™ Apply Fiters ] [»] [ 2]
come in via the it Sesch P , Ea Code | Nane S
H I GOS  Lamy Boxer
pairing or room, e ; pssgrmerts| | €49 Lovie Winan 5
f .
yOU | | Sta rt Wlth I~ In Restrictions 7
. I 8
the section you = sty 9
i _cli . I in 0Bob Brown [] * 10
”ght C“Cked on! B 2 Brenda Brown (*J) e Billy Bob () _xJ m
H 0 Chris Carter [R) L Deshae
OtherW|Ses the ¥ 0 Chiisty Chapman () - Sips ERcg
H : ¥ In 1 Carla Clayton (*R) *
o CX.LD,PF
d efau |t Settl n g IS I inc 1 geoffrﬁey Gexulyel (*S) :  Beta High Schol) 3 enties]
. . - reg Grey (*S) e
start with section 2 George Guyer (*S) Public Forum Flound 1 Friday 04:00PM Section 7 Reom 107 [Flight 1)
| mf 0 Paul Picker [*H) Public Forum Round 1 Friday 04:00PM Section 8 Room 107 [Flight 2)
O n e . ~ 0 Peter Piper (*H)
- 0 Patricia Pourier (*H)
ke 0 Rachel Radimer (*Q)
IV Include Nor-obligated 2 Raphael Ramiriz (*Q) Sort by
Fegion 'h 2 Roger Reyes (*Q) @ Last Name
2 5 0 Ralph Rizjak (3] " First Name
District any v 0 Rory Rodriguez (@) § ¢ Code
" = = 0 Stacey Sharebox (*N) o
Rang [y ] 0 Steve Sty (N) € Distict
Flag any v 0 Stan Steer [*N) " Region
- # Assignments 0Tory Tambia (T) " #Rounds
v - 0 Thomas Tank (*T) oo
; 2 Tim Teeboat (*T) - Friony,
0 93 Update
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Event D Dobate = Judge Search ieavch Assigned Judges 08:004M Saturday
. Al
Round m New st Cancel

. - Possible Judges (37) t
Secion o] ool Bl e _oie | e
I™ by Bracket <anonymous judge> -~

B
|i

I~ Apply Filters
Edit | Name

Larry Boxer

Judge Search Filters

1
[ 2]
[ e | A
] : v B B
Assignments Louise Wildman 5
6
[ ]
Note the [ 2
Competltors to ' 8
: EET 9
whom you wish to 0 Bob Brown ] * 10
. . d I f 2 Br(_enda Brown (*J) ) m
assign a judge. 0Chis Cater (F) ) oetie F1 P2 F3
. 0 Christy Chapman (*R)
you click on one of 1 CataCiaton ()
: 1 Gcolliey Bouyer 3], . § et High School 3 enes]
the competitors 1GeaGiey (5] .
! 2 George Guyer (*S) - Public Forum Round 1 Friday 04:00PM Section 7 Room 107 (Flight 1)
yo u WI | | S e e th e 0 Paul Picker [*H) Public Forum Round 1 Friday 04:00PM Section 8 Room 107 (Flight 2]
0 Peter Piper (*H)
1 0 Patricia Pourier [*H)
detalls Of that 0 Rachel Radimer (*3)
2 Raphael Ramiriz (*Q) Sort by

& Last Name

competitor in the

. = 2 Roger Reyes (*Q)
. Ragon |3y 0 Ralph Riziok (10) € First Name
bOX On the rlght District any v 0 Rory Rodriguez (@)  Code
: = = 0 Stacey Sharebox *N) o
Raing oy | 0 Steve Smity (N] € Distict
Flag any v 0 Stan Steer [*N) " Region
- # Assignments — | |0Tory Tambia (T) " # Rounds
0 Thomas Tank (*T) b
2 Tim Teeboat (*T) - Priority

e Choose a judge

frO m th e Evert ,W] Judge Search Search Assigned Judges 08:00AM Saturday

. @ Al x
PO SSI b | e Round  [Round 1 v M -~ ﬁ - 3 Brenda Brown ) Cancel
Section m Possible Judges (36) _7' NSsSI00e bt i
Ju d g es bOX_ : 7(‘ Un-Pooled _] o

- L-D Debate Debaters Seen -
J18 Sierra Woollard (as 4ff) Round 1
T07 Pansy Jowers [as Neg) Round 1

When you click SRS i 1
y . I~ Apply Filters _J LI §
On a partlcu Iar - Judge Search Filters Edit Code | Name i i
H - nelude Judaes not ir GO5  Larry Boxer
Judge you WI | | rlj, : it i, Assignments C49  Louise Wildman é
see the details ™ Restictons -
. . I inc 8
for that judge in i History °
I n syl 0Bob Brown (%)) * 10
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H = 0 Christy Chapman [*R) ossioe M1 W2 V3
rlg ht B 4 1 Carla Clayton [*R) * E Swaps : o
W In n chee udas 1 Geoffrey Geuryer [*S) = — = —
[T e e 1 Greg Grey [*S) s I:X,Jtdg'mg in section 2 ()
=i et Q Rho Noth High School [1 entry]
0 Paul Picker [*H)
I in 0 Peter Piper [*H) Public Forum Round 1 Friday 04:00PM Section 11 Room 109 (Flight 1
. o (¥ Public Forum Round 1 Friday 04:00PM Section 12 Room 109 (Flight 2
2 2 elicia Pousiee (H) LD Debate Round 1 Satuday 08:004M Section 2
5 In 5
¥ i

~Sort by —
@ Last Name

© First Name

N [ﬁ 0Ralph Rizjak Q)
Fegon Sj=b 0 Rory Rodriguez (*3)
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This box shows information about the

4 " Code
Rating  [ay - gg:::‘asfe"::‘;:‘;“‘ € Distict judge's assigned pool, school details. and
Flag any v 0 Tory Tambia (*T) " Region aSSignment hiStOI’y.

0 Thomas Tank [*T) " #Rounds
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0 93 Update
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e Ifthisis the judge
that you wish to

Event ,ml Judge Search ieavch
. o -
choose, double-click || rors fomai < [ oo | |E8 s | [ G
. Section m Possible Judges (36) iI S
on the judge name. € UnPokd :
J g . I by Bracket <anonymous judge> 1
The selected judge s » 2
. . ) = - 3
Judge Search Filters Edit Code | Name
will appear in the r : L& | ol — 2
b OX | ab e | e d = Assignments €49 Louise Wildman l%
k)
Assigned Judges 2 [ i
. | | t 8
Click OK ol B 0
) ] 0 Bob Brown 1) * 10
71 0 Chris Carter [*R) ’ Raphael Ramiiz () _><_J 1
0 Chisty Chapman (R) Possble
] 1 Carla Clayton (+R) * Syees 2 e g
3 1 Geoffrey Geuryer 'S) — —
il 1 Greg Grey [S) o E><Jt[d)glr\g in section 2 ()
i . . r Agsi;m?en. (@ Rho North High School) [1 entry]
N OT E . T h I S d I al Og Offe rs | 0 Peter Piper (*H) Public Forum Round 1 Friday 04:00PM Section 11 Room 109 (Flight 1
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£ d 3 Raphael Ramiriz (*Q) i - L-D Debate Debaters Seen -
H V' Include Non-obfigated 3 Roger Reyes (*Q [~ Sortby 18 Sierra Woolard (as Aff) Round 1
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§ Use this box to search
for a judge by name.
LY

Click the "?" to understand
yhe color coding.

'

Event

Intemational Extemp v
Found  [Round1 v
Section  [Section 1 Fioom 101 M

™ by Bracket

™ Apply Filters
O ——— earch Filters
This option Fclude .

allows youto
turn on the
ability to "Apply
Filters" to the
Possible
Judges list.
You will be able
to specify more
paremeters for
judge criteria in
this section.

egion |any v
tict  |any v

Rating

any

Flag any

- i Assignments

‘l udge Search
| New
Possible Judges (36)

Search

Assigned Judges

Click here to substitute a 1
judge already assigned
to this rtund/section.

© Al

" Unassigned
" Un-Pooled

2]

<anonymous judge>
3 Alan Albertson [T}

1 Carla Clayton [*R) ' Cancel
‘—I Section -
1
This box shows 2
3

0 Alice Alverno (*C)|

0 Julie Ambrose (*C)|

Name

Dylan Buehler
lan Eden
Anona Dugmore
Doris Akers
Nora Smith

the students in
| this section.

0 Alicia Asmore (*C)
0 Bob Brown (*J) *
0 Chris Carter (*R)

0 Christy Chapman (*R)
1 Geoffrey Geuryer (*S)

assignments, restrictions or |__| that person is
history of a judge. dirty” for a
particular section,

£ N
When you click on
a judge name, if

Use these buttons to edit a
judge or look up the

1 Greg Grey (*S)
3 George Guver [*S
0 Paul Picker (*H)
0 Peter Piper (*H)
0 Patricia Pourier (*H)
0 Rachel Radimer (*Q)

I Sort by

3 Roger Reves (0
& Last Name

0 Ralph Rizjak (*Q)

the number of that
section will be
shaded in red.

|

When you click on a

0 Rory Rodriguez (*Q) " First Name:

judge the

0 Stacey Sharebox (*N)

" Code
0 Steve Smirty (*N) =
0 Stan Steer (*N) District
0 Tory Tambia (*T) " Region

0 Thomas Tank (*T)
3 Tim Teehoat [T}

" # Rounds

= Click one of these

information about
that judge appears

optionsitosart e here in this box.

Possible Judges list.

0 Tara Treatier (*T)

 Priority

11. Addendum - If needed, add a judge, enter a school, or add a new entry.

A. Add Judges - NOTE: You may only need this option if you are entering non-school affiliated
judges (hired or volunteer); otherwise, you can skip this step if you have imported the entries

from the website.

school will need to be h

and-entered.

The website will only allow for entry of “school-affiliated” judges. Judges not affiliated with a
If you didn’t use the website or if you need to add hired

or volunteer judges to the tournament you may do so by right-clicking on the Judges folder on
the navigation tree on the left and select Add.

The Edit Judge box will appear. While this dialog has numerous options, the only field that is

required is the judge's name. All of the other fields reflect additional information that you may
use to assist you in the process of contacting, recording, and assigning judges.
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Edit Judge - L3 [
| Sl == |
Abbr | " byCode (& Name Work I Close
School [<none> | Cell | Restrictions
Region I ;] Pager I
District I L] E-mail l
Note I

Events Times
International Extemp Availahilities [ Unavailahle
"0 Date |Friday l..’
Origina b Add >>
Humorous Interp From 08:00 AM -
Dramatic Interp - |
Duedmerp To  [osoopm =]
Public Forum
# Rounds 0 [v AsNeeded |Normal v l
Obligation Base Priority Rating I v
[V Any Event i
| Private Note I
[T Confirmed [T Don'tUse [ Stop Using
[~ Checked In [~ Coach
[ No Show [V Prelims
[ Hired [v Elims
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e Each of the fields on this dialog is described in the following table.

Field

Description

Name

The name of the judge. This is the only required field for defining a judge.
Each judge must have a unique name. This name will be displayed on
ballots and postings where judge information is provided. Typically you
will want to provide full names, as in John Brown, and Julie Smith, but
you may use whatever names you desire (for example, last name only).

Code

The judge code. Options exist in various places to display a judge code
instead of the judge name. If you want to use those features, you must
provide a code for each judge. The code can be anything you want it to
be. It is recommended that you use a short code (3-4 characters).

School

This field allows you to record a school affiliation for the judge. By
recording the affiliation, you are automatically recording a judge
restriction; they will not be scheduled to judge competitors from the
affiliated school. Additional restrictions may be coded for the judge. The
affiliation field is used to record the primary affiliation. If you are requiring
that judges be provided by each school, use this field to record the
school that receives the credit for providing the judge.

Region

Use this field to indicate the region the judge represents. If you are
attempting to balance judges by region, the software will use this field.

District

Use this field to indicate the district that the judge represents. If you are
attempting to balance judges by district, the software will use this field.

Note

This field provides a customized note for each judge. The note will
appear on assignment sheets given to the judge. You may provide
personalization to your assignments using this field. Examples: Hey Joe,
stop by the tab room — | have a trophy for you from last week’s
tournament, or Thanks for judging Mary.

Phone

Primary phone number to use to reach the judge.

Work
Phone

Work phone number of the judge.
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Field

Description

Cell Cell phone number of the judge.

Phone

Pager Judge's pager number.

Email Use this field to record an email address that may be used to reach the
judge.

Events The events this individual may actually judge. Initially, the Any Event
check box will be checked indicating that the judge may be scheduled in
any event. If so, the list of events will be disabled. If Any Event is
unchecked, then the events highlighted in this list represent the events
for which the judge may be scheduled.

Any Event | If checked, indicates that the judge may be assigned to any event for
judging.

Date / Use these three fields to indicate when a judge has indicated they will be

From /To | available. You may then press the button labeled Add >> to move the
availability into the list of times the judge is available (labeled
Avalilabilities). You may remove an availability by highlighting the time in
the list and pressing the button labeled Remove.

Unavailable | Use this checkbox to indicate that a judge is not available for any judging
slots.

# Rounds | Maximum number of rounds for which the judge should be scheduled.
This box will be disabled if the As Needed box is checked. The
application will honor this limit when instructed to do so. You may over-
ride the limit by making assignments manually or requesting that the
limits be ignored when automatically assigning judges.

As Indicates that the judge may be used for as many rounds as needed. In

Needed other words, this indicates that there is no maximum number of rounds
allowed for the judge.

Normal / If you have indicated that the judge be used As Needed, this field

Light/ provides an additional level of priority for using the judge. Light indicates

Medium / | that the judge should be used as few times as possible; Heavy means as

Heavy many times as possible. Medium indicates the judge should be used
slightly more than Normal, but not excessively. Normal is the default.

Obligation | Use this field to record the number of rounds the judge is obligated to
judge.

Base Judges are assigned based on a priority system. Judges normally start

Priority out with a priority of zero. If you want to favor this judge for assignments

(that is, place them in more rounds), assign a base priority for the judge
greater than zero. The priority scale by default runs from zero to
approximately 100. Higher numbers result in more assignments; lower
numbers result in fewer assignments. You may also assign a negative
number to reduce the likelihood of assignments for the judge. The actual
judge that is assigned to each slot is based on a number of things. When

Page 38 of 47

Before the Tournament Guide

Revision: Jan. 2017



Joy of Tournaments User Guide for NSDA District Tournaments [BEFORE]

Field Description
all other considerations are equal, the software assigns the slot to the
judge with the highest priority.

Rating Use this field to rate the judge. Ratings are based on a scale from A to E.
A represents the best rating.

Private Use this field to keep a private note. This note will only appear on this

Note dialog. You may keep notes here that you would not necessarily want the

individual to see. For example, Avoid interp events, Argumentative.
Caution is advised not to over use this field.

Confirmed | This field may be used to track judge confirmations. After receiving a
confirmation for the judge, check this box. If you choose, confirmed
judges may receive a different priority for judge assignments than
unconfirmed judges.

Checked You may use this field to track which judges have Checked In or that you
In know are present at the tournament. When assigning judges, this can be
used to alter priority for assignments.

No Show | This field may be used to indicate that the judge is a No Show.

Hired Use this field to indicate that a judge is hired. Extra options exist within
the software for hired judges to assist in payment.

Don't Use | When this field is checked, the software will mark the judge as being
completely unavailable. The software will not assign judges with this
attribute set. Additionally, you will be warned if you attempt to assign a
judge that has been marked Don't Use. Use this field primarily to indicate
that a judge previously thought available has become unavailable for

use.

Coach This field allows you to mark the judges that are coaches. You may use
this field to alter the priority of assigning coaches as judges.

Prelims If checked, indicates that the judge may be used in Preliminary rounds. If
unchecked, the judge will not be assigned to preliminary rounds of
competition.

Elims If checked, indicates that the judge may be used in Elimination rounds. If
unchecked, the judge will not be assigned to elimination rounds.

Stop When this field is checked, the software will stop assigning the judge for

Using additional rounds. Any existing assignments will be retained, but the

software will not automatically add any assignments to the judge.
Additionally, you will be warned if you attempt to assign the judge after
marking them with the 'Stop Using' flag.

e NOTE: Additional flags may appear on the bottom of this dialog if you are using user-defined
judge flags (these flags were set up in the initial website preparation process). User-defined
flags will appear following the 'Stop Using' flag.
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When you return to the
judge page (click on
Judges) to view the

judge list, the

hired/volunteer names
will have a special
code next to the name
to indicate they are

hired.

File Edit View Reports Help

[BEFORE]

‘_ NFL SAMPLE - The Joy of Tournaments

B& = ]E| 2| [<an> v [<alTime <] | | Set] ¢
0 vents Judge Usage <
&0 Schools Friday, 03/07/08 B
CREudges| 5
(3 Ratings 8:00 9:00 10:0011:00noon 1:00 2:00 3:00 {
(1 Regional Load ) Z
(3 Pool (Grid) g,rlcl)gke Blr(]g,\r}la)lm (V) )
2 2 ill Brown (*! £
[ e Bill Brown (*U) 5
-3 Available Joanne Brown (*C) E
-3 Available by Time Mark Cicero (*A) D
[ Assigned Jennie Cook (*R) 3
- Liz Epicurus (*O) &
=-3 St : :
= Cum;naryf Gina Goodman (*S) 3
T T Grant Goodman (*S) 5
(3 Unconfirmed George Greene (*S) b
(3 Hired {
& by School k2 L ' <
1.l : <$> Mister Judge 3
-8 by Time KT KISMemts ("M) %
(3 Open Slots 7
@~ by Name Paul Newton (*E) 7/
-3 Rooms Shelia Patterson (*E) 3
5@S Laurie Spear (*J) 3
& smeedpi Zeke Stockton (*G) {
maciedUle <C> Gerald Thompson (*H) &
-3 Actions Tim Timmons (*D) <
Zane Williams (*G) }
Emily Zhou (*G) {
;/
4
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B. Add a school. Right-
click on the Schools

x|
folder and select the

option labeled Add from Code [ Heme | Close
the dropdown menu.
Selecting this option will Coach | Phone |
bring up the dialog that Addil | Fax |
appears. This dialog addi2 | o
gllows you to store the Ciy | Emal |
;ngﬁ(r)rglz.atlon about a e
e There are only two fields Division | =l " Hasdnived [V TFA Member
on this dialog that are e | 2 SquadCount |
required: Code and Region | = gty Pos [
Name. The remaining B
fields are all optionaL - Additional Coaches - Affiliated Judges
Use the chart below to Add

determine the
information that you may
enter in the different

fields.

e Using this dialog, you may enter the appropriate information for each school. Be sure to press
the button labeled Enter. This will store the information you have entered for the current school
and clear the dialog for entry of the next school. When you have finished with the dialog, press
the button labeled Close.

Field Description

Code A short code that will be displayed to represent the school on all reports. It can be
numeric, alphabetic, or anything else you want; however, the code you choose
should be short — typically 1 or 2 characters. For NSDA districts, school codes
are typically alphabetic.

Name The actual name of the school or squad. Typical values are Friona, Friona High
School, Texas A&M University, Amarillo High Gold Squad, etc. This is a
descriptive name of the team. Result pages generally display the name of the
school.

Coach The name of the (primary) coach or sponsor for the school.

Addr 1 First address line.

Addr 2 Second address line.

City City that the school represents.

State State

Zip Zip Code
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Field Description

Phone Phone number of the school.

Fax Fax number of the school.

Home Coach’s home phone number.

Phone

Email Coach’s email address.

Notes A text field that allows you to keep short notes about the school. This field does
not appear on any reports.

Has Used to mark a school as arrived. The arrival status may be tracked during

Arrived registration allowing you to know which schools have/have not checked in.

Squad Number of competitors from this school. This number is used in the calculation of

Count squad efficiency. If you leave this number blank, the application will automatically
calculate this number. If you supply a number here, the number you supply will
over-ride the automatic calculation.

Trophy This option is only available for NSDA District Style tournaments. Record the

Points trophy points retained from previous district competition in this field.

Additional | A list of additional coaches for the school. Use the Add and Remove buttons to

Coaches | edit the names on this list.

Affiliated | A list of judges that have been coded as affiliated with the school. Used primarily

Judges to determine if a school has provided sufficient judges.

2004 HI L Distric) Tewvnament - The Jay ol Tewnaments

Humorous

0 Eririee

C. Add a new entry. There
are multiple ways to enter
competitors in the
software. Here is the
recommended process for
manually typing in the
entries.

e Go to one of the events on
the navigation tree (it really
doesn't matter which one
you select). Open up the .
Events folder to reveal the ‘ :
"entries"” folder beneath it. Right-click and select Edit from the context menu.

Bschupin pasgrate Sinsdakore: .19
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e From the School dropdown menu, select the appropriate school from the list. (If the school is
missing, you may use the "Add" button to add the school; see the previous section for

information about adding
a school.) Entries by Event @
School | =] Add. ] Close |

Devine High School (&)

Eai le Mountain Hiih School iF|

Falmouth High Schoal (B

Event  IMarion High School (E)
Rochester High School (D]

Contestan\westfield High Schoal [C)

| e e |

Squad Members (&ll)

L

- Sort / Search by
* FistName O LastName
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e From the Event dropdown Entries by Event
menu, select the appropriate

event from the list. Schoal IFaImoulh High School (B)

~] Add. | _ s |

Sot by Name " by Code

Event lHumorous

Ed

Humorous

Contestan py, Smate

Squad Mg Dua Interpretation
L-D Debate
Policy Debate
Public Forum

,—‘ | Dratory
US Extemp 2
|nternational Extemp

yous entries [0)

- Sort / Search by
* FistName T LastName

e Type in the name of the
contestant in the field labeled Entries by Event
"Contestant Name".

School  |Falmouth High School (B)

~] Add. | _ s |

Sot % by Name " by Code

Event |lntemati0nal Extemnp

Contestant Name

Squad Members (&ll)

¥

|John Doe M A ]

International Extemp entries [0)

LA

i~ Sort / Search by
* FistMame T LastName

Page 44 of 47 Before the Tournament Guide

Revision: Jan. 2017




Joy of Tournaments User Guide for NSDA District Tournaments

[BEFORE]

e Press the Enter key on the
keyboard (some keyboards label
the key "return”). This will cause
the student's name to appear in
both the Squad Members box on
the left-hand side and in the right-
hand box labeled "International
Extemp entries" (or whatever
event is selected).

e Continue with this process to
enter each of the students from
the School/Event combination you
have selected. You may change
to a different event and/or a
different school as you process
additional entries.

e The Squad Members list will
include all of the students from
the selected school that are
entered in any event.

e The Entries list in the bottom
right-hand box will list just the
students from that school that are
entered in the selected event.

Entries by Event @
Close

School IFaImoulh High School (B) lJ Add...
Sot [+ byName " by Code
Event  |Intemational Extemp R

Contestant Name

Il [ hame Change |
Squad Members (&)
John Doe

International Extemp entries [1)

John Doe

B2

- Sort / Search by

* FistName T LastName

Entries by Event @
Close

School | Falmouth High School (B) ~] Add. |
Sot 1 byName " by Code

Event  |Dramatic Ra

Contestant Name
| bl .
Squad Members (&) Dramatic entries (1)
&lan Brown John Doe

Mk Wikans 57

Shelia Smith

- Sort / Search by

% FirstName  © LastName
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As areminder, these instructions are not intended to be exhaustive of the entire software
program. They are meant to guide you through your NSDA District Tournament. For a more
specific explanation of these steps, refer to the manuals found on
www.JoyofTournaments.com/help/.

For software support, please call 806-773-0162
(available via Monday to Saturday).
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